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Installation and Configuration

Installing the Win4156 Software

Note: Do not install the USB Security Key until after the Metrics Win4156 Software
is installed and the PC is restarted. The security key requires special drivers that are
installed with Win4156. Windows Hardware Manager should detect the USB
Security Key as Safenet USB SuperPro/UltraPro and install the driver automatically.

The installation program for the Metrics Win4156 software installs all components
necessary to run Metrics Win4156. You can download the auto-extracting archive
MTWA4156-41.EXE from the Metrics Technology website under Downloads link. Be
sure to save the install file to your local hard disk before running the installation.
Running the installation from the website will cause an installation error. You will
need a valid customer login to enter the Software Downloads area.

NOTE: You should also download the latest available hot fix release which can be
found in the same software list and designated MTW4156-41-HFXX.EXE where the
XX is the version of the hot fix. Hot fixes contain resolutions to any reported issues
and some enhancements that have been added since the initial release of Metrics
Win4156 4.1. It is only necessary to apply the latest hot fix to your system since all
updates are contained in the latest build. Save the hot fix file to your local computer
and you can install it after the base Metrics Win4156 installation is complete.

Obtain a Codeword

This codeword is obtained by registering your software with Metrics Technology.
Please visit our website at www.metricstech.com to register your software and obtain
the codeword.

Important Note for Customers upgrading

The Metrics Win4156 setup program requires that you backup and uninstall the
previous version. To do this, please perform the following steps:

DO NOT LEAVE YOUR BACKUP ARCHIVE IN THE METRICS DIRECTORY!

COPY THE BACKUP.ZIP FILE TO A DIFFERENT LOCATION LIKE A USB
DRIVE.
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Go to the File Menu and select Backup

2. Enter the name of the backup ZIP archive in the W4156 directory (i.e.
C:\METRICS\W4156\backup.zip)

3. Allow the backup utility to complete then copy the .ZIP file to another

drive location.

After upgrading, some of the functions of the software will require that older projects
or features be modified. A brief list of the modifications are:

Metrics Win4156 files are now be stored in the windows file system. Existing tests
should be opened and then saved in the Metrics\ics\projects directory.

Procedure to Upgrade Win4156 from 4.0 to 4.1

1. Insert the Metrics Win4156 install CD into the CD-ROM drive of your
compulter.

2. The CD-ROM should automatically start the Setup.exe installation program.
If the installation does not start automatically then select right click on the
CD drive icon in Windows Explorer and then select "explore™. Select the
Setup.exe application icon to start the installation program manually.

A Metrics Win4156 Setup X

Welcome to Metrics Win4156 Setup Advanced Installer

Welcome to the Wizard for Metrics Win4156 Setup.

. Collecting information

‘ Preparing installation

’ Installing I:ioiehtsse\f‘lizard will install Metrics Win4156 on your computer. Please dick Next”

@ rinalizing installation

3. Click Next button on the "Welcome" panel.
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| A Metrics Win4156 Setup

End-User License Agreement

Collecting information
Preparing installation
Installing

Finalizing installation

b

Advanced Installer

Metrics Technology Software FProduct

End User License Agreement and Limited
Warranty

IMPORTRNT: Please carefully read the License
BLgreement below before clicking "I accept the
terms in the License Agreement" The right to
use this Metrics Technology software Product

pt the terms in the Lic

@ I do not accept the terms in the License Agreement

4. Read the "Software License Agreement™ and click the I agree to the terms
in the License Agreement button to agree to the terms. Then click Next.

A Metrics Win4156 Setup

Installation Folder

Collecting information
Preparing installation
Installing

Finalizing installation

Installation and Getting Started
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Advanced Installer

This is the folder where Metrics Win4156 will be installed.

To install in this folder, dick "Next". To install to a different folder, enter it below or dick
"Browse".

Folder:



5. Choose "destination location" for installation and click the Next button.
NOTE: It is recommended to select the default C:\Metrics\ as the location to
maintain compatibility with previous versions of the software backups.

A Metrics ICS Setup x

Ready to Install Advanced Installer

The Setup Wizard is ready to begin the Metrics ICS installation.

o Collecting information

® rreparing installation Click "Install" to begin the installation, If you want ko review or change any of your
installation settings, click "Back". Click "Cancel” to exit the wizard.

‘ Installing

‘ Finalizing installation

Cancel
L _J

6. Click the Install button to begin the Metrics Win4156 installation.

i@ Sentinel System Driver Installer 7.5.7 - InstallShield Wizard 3

Welcome to the InstallShield Wizard for
Sentinel System Driver Installer 7.5.7

The InstallShield(R) Wizard will install Sentinel System Driver
Installer 7.5.7 on your computer, To continue, click Next,

WARMING: This program is protected by copyright law and
international treaties.

[ Mext» | [ Cancel
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7. The Safenet Sentinel Pro driver installation will now be started to install the
security license components.

Program Maintenance

Modify, repair, or remove the program.,

@ Modify

Change which program features are installed. This option displays the
Custom Selection dialog in which you can change the way features are
installed.

Repair installation errors in the program. This option fixes missing or
corrupt files, shortcuts, and registry entries,

Remove Sentinel System Driver Installer 7.5.7 from your computer.,

InstallShield

[ < Back ][ Next = ] [ Cancel

8. Select Modify setup type and click the Next button.

il Sentinel System Driver Installer 7.5.7 - InstallShield Wizan

Custom Setup

Select the program features you want installed.

Click on an icon in the list below to change how a feature is installed.
Feature Description
e =1 | sentinel System Drivers . ) 3 .
T . The device driver for Sentinel
foees =0 = | USB System Driver keys
= ~ | Parallel Driver

This feature requires OKB on
your hard drive. It has 0 of 2
subfeatures selected. The
subfeatures require OKB on your
hard drive.

C:'\Program Files (x86)\Common Files\SafeMet Sentinel\Sentinel System Driver),

InstallShield

[ < Back ][ Mext = ] [ Cancel

9. Click Next to start select the custom installation.
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Ready to Install the Program

The wizard is ready ko begin installation.

Click Install ko begin the installation,

If vou want to revies or change any of your inskallakion settings, click Back, Click Cancel ko
exit the wizard,

[ < Back ]| Inskall q [ Cancel

10. Click Install to start the Sentinel Driver installation.

i Sentinel System Driver, Installer 7.5.7 - InstallShield Wizard E||§|Pg|

Installing Sentinel System Driver Installer 7.5.7

The program Features wou selecked are being installed,

Please wait while the Installshield Wizard installs Sentinel Svstem Driver
Installer 7.5.7. This may take several minukes,

Skatus:

Zancel

11. Allow the installation to complete.
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i& Sentinel System Driver, Installer 7.5.7 - InstallShield Wizard ['X|

InstallShield Wizard Completed

The Instalishield Wizard has successfully installed Sentine
System Driver Installer 7.5.7. Click Finish to exit the wizard.

< Back Cancel

Then click Finish to continue with the Metrics Win4156 installation.

12. Allow the Metrics Win4156 installation to complete.

A Metrics Win4156 Setup X

Installing Metrics Win4156 Advanced Installer

o Collecting information
o Preparing installation
. Installing

@ Finalizing installation

Installation and Getting Started
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| A Metrics Win4156 Setup

Metrics Win4156 Setup Complete Advanced Installer

Click the "Finish" button to exit the Setup Wizard.

o Collecting information
o Preparing installation
o Installing

. Finalizing installation

Then click Finish to complete the installation.

13. After the installation is finished, re-start the computer.

‘ji) You must restart your system for the configuration changes made to Metrics ICY to take effect. Click ™Yes” to restart now or No ™ if you plan to

manually restart later.

14. Connect the USB Security Key to the USB port of your computer. The
Windows Hardware Manager should detect the USB device as Safenet USB
SuperPro/UltraPro and should automatically install the driver for the device.

Note: It is recommended the security plug be connected directly to the
computer instead of through a USB hub or keyboard port if possible.
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Procedure to Install Win4156 (new installation)

1. Insert the Metrics Win4156 install CD into the CD-ROM drive of your
compulter.

2. The CD-ROM should automatically start the Setup.exe installation program.
If the installation does not start automatically then select right click on the
CD drive icon in Windows Explorer and then select "explore". Select the
Setup.exe application icon to start the installation program manually.

The installation will check for any prerequisites and start the Prerequisites
Wizard to install the necessary software. Please note installation of some of
these software components requires acceptance of the 3™ Party license
agreements displayed during installation. Installation of some components
can take some time so you should allow more time for installation if these
components are not already installed on your workstation PC.

Welcome to the Prerequisites
Wizard

The setup has determined that some of the
prerequisites needed to run this program are
missing. This wizard will assist you in getting and
installing those prerequisites. Click Next to
continue to the list of prerequisites.

Click Finish at any time to completely skip the
installation of prerequisites and jump to the
installation of the main program. Click Cancel to
cancel the installation and exit the Setup Wizard.

3. Click Next button on the "Welcome" panel.
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Prerequisites

These programs are needed for the application to run. Click on the chedk box
next to a prerequisite to select it for install or to skip it.

Mame Version Action

MET Framewark 4.0 Required: 4.0 or higher. Found: ... Install
Visual C++ 2010 Redistributable 86 Required: any. Found: nothing. Install

Press the Mext button to install the prereguisites.

4. Click Next button on the "Prerequisites™ panel.

ES Microsoft .NET Framework 4 Setup

.NET Framework 4 Setup N
Please accept the license terms ko continue. Hkmof
~
MICROSOFT SOFTWARE v
[T have read and accept the license kerms . =) H
Download size estimate: 0 MB
Download tine estimates: Dial-Up: O minutes

Broadband: 0 minutes

[Jxes, send infarmation about my setup experiences ta Micrasoft Corparatian,

Far more information, read the Data Collection Policy,

Install l’ Cancel
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5. Click I have read and accept the license terms then click the Install button
on the "Microsoft .NET Framework" panel.

E% Microsoft .NET Framework 4 Setup g|§|@
Installation Is Complete

N .MET Framework 4 has been installed.

Microsoft*

Check Far more recent versions on ain

6. Click Finish to continue.

E& Microsoft Visual C++ 2010 x86 Redistributable Setup

Welcome to Microsoft ¥isual C++ 2010 =86 Redistributable Setup
Please, accept the license terms to continue, w

WICROSOFT SOFTWARE LICENSE TERMS

MICROSOFT ¥ISUAL C+ + 2010 RUNTIME LIBRARIES WITH
SERYICE PACK 1

These license terms are an agresment betweean Microsoft
Corporation (or based on where you live, one of its affiliates) and
you. Please read them. They apply to the software named above, o

[T have read and accept the license kerms, i ﬂ

[]ites, send infarmation about my setup experiences ta Microsoft Carporation.

For more information, read the Data Collection Palicy,

I Install ][ Cancel ]

7. Click I have read and accept the license terms then click the Install button
on the " Microsoft Visual C++ 2010 Redistributable " panel.
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ES Microsoft VisualC++ 2010 x86 Redistributable Setup

Installation Is Complete

Mmm Micrasoft Yisual C++ 2010 %56 Redistributable has been
H T~ installed,
Visual Studio

ou can check for more recent versions of this package on
the website,

8. Click Finish to continue.

A Metrics Win4156 Setup X

Welcome to Metrics Win4156 Setup Advanced Installer

Welcome to the Wizard for Metrics Win4156 Setup.

Collecting information

Preparing installation

The Setup Wizard will install Metrics Win4156 on your computer. Please dick Next®

Installing to continue,

Finalizing installation

9. Click Next button on the "Welcome" panel.

Installation and Getting Started

15



| A Metrics Win4156 Setup

End-User License Agreement

Collecting information
Preparing installation
Installing

Finalizing installation

b

Advanced Installer

Metrics Technology Software FProduct

End User License Agreement and Limited
Warranty

IMPORTRNT: Please carefully read the License
BLgreement below before clicking "I accept the
terms in the License Agreement" The right to
use this Metrics Technology software Product

pt the terms in the Lic

@ I do not accept the terms in the License Agreement

10. Read the "Software License Agreement"” and click the | agree to the terms
in the License Agreement button to agree to the terms. Then click Next.

A Metrics Win4156 Setup

Installation Folder

Collecting information
Preparing installation
Installing

Finalizing installation

Installation and Getting Started

- X

Advanced Installer

This is the folder where Metrics Win4156 will be installed.

To install in this folder, dick "Next". To install to a different folder, enter it below or dick
"Browse".

Folder:
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11. Choose "destination location™ for installation and click the Next button.
Note: It is recommended to select the default C:\Metrics\ as the location to
maintain compatibility with previous versions of the software backups.

A Metrics ICS Setup x

Ready to Install Advanced Installer

The Setup Wizard is ready to begin the Metrics ICS installation.

o Collecting information

® rreparing installation Click "Install" to begin the installation, If you want ko review or change any of your
installation settings, click "Back". Click "Cancel” to exit the wizard.

‘ Installing

‘ Finalizing installation

Cancel
L _J

12. Click the Install button to begin the Metrics Win4156 installation.

i@ Sentinel System Driver Installer 7.5.7 - InstallShield Wizard 3

Welcome to the InstallShield Wizard for
Sentinel System Driver Installer 7.5.7

The InstallShield(R) Wizard will install Sentinel System Driver
Installer 7.5.7 on your computer, To continue, click Next,

WARMING: This program is protected by copyright law and
international treaties.

[ Mext» | [ Cancel
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13. The Safenet Sentinel Pro driver installation will now be started to install the
security license components.

i Sentinel System Driver Installer 7.5.7 - InstallShield Wizard

License Agreement

Please read the following license agreement carefully,

License GrantWarranty for Software ~

This License describes limited rights granted by Safellet, Inc. andfor one of its
subsidiaries (such grantor, "Seller”) to the Buyer.

A.  Theterm "Software”, as used herein, shall mean a program or programs
cangisting of machine readable logical instruction and tables of infarmation
designed as libraries or drivers to work in conjunction with Seller's Sentinel
Keys ("Products”). Title to all Software furnished to Buyer hereunder shall

........ Dl D mllme mvmend - - O

W

E T T P e Tl o Py

(331 accept the kerms in the license agreement:

(1 do not accepk the kerms in the license agreement

[ < Back ” et = l [ Cancel ]

14. Read the "Software License Agreement"” and click the | agree to the terms
in the License Agreement button to agree to the terms. Then click Next.

i Sentinel System Driver Installer 7.5.7 - InstallShield Wizard
Setup Type

“hoose the setup tvpe that best suits your needs,

Please select a setup bvpe,

All program features will be installed, {Reguires the mosk disk
space, )

(") Custom

hoose which program features wou wank installed and where they
will be installed, Recommended for advanced users.

[ < Back “ Mext = ] [ Cancel

15. Select "Complete™ setup type and click the Next button.
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Ready to Install the Program

The wizard is ready ko begin installation.

Click Install ko begin the installation,

If vou want to revies or change any of your inskallakion settings, click Back, Click Cancel ko
exit the wizard,

[ < Back ]| Inskall q [ Cancel

16. Click Install to start the Sentinel Driver installation.

i Sentinel System Driver, Installer 7.5.7 - InstallShield Wizard E||§|Pg|

Installing Sentinel System Driver Installer 7.5.7

The program Features wou selecked are being installed,

Please wait while the Installshield Wizard installs Sentinel Svstem Driver
Installer 7.5.7. This may take several minukes,

Skatus:

Zancel

17. Allow the installation to complete.
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i& Sentinel System Driver, Installer 7.5.7 - InstallShield Wizard ['X|

InstallShield Wizard Completed

The Instalishield Wizard has successfully installed Sentine
System Driver Installer 7.5.7. Click Finish to exit the wizard.

< Back Cancel

Then click Finish to continue with the Metrics Win4156 installation.

18. Allow the Metrics Win4156 installation to complete.

A Metrics Win4156 Setup X

Installing Metrics Win4156 Advanced Installer

o Collecting information
o Preparing installation
. Installing

@ Finalizing installation

Installation and Getting Started
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| A Metrics Win4156 Setup

Metrics Win4156 Setup Complete Advanced Installer

Click the "Finish" button to exit the Setup Wizard.

o Collecting information
o Preparing installation
o Installing

. Finalizing installation

Then click Finish to complete the installation.

19. After the installation is finished, re-start the computer.

‘ji) You must restart your system for the configuration changes made to Metrics ICY to take effect. Click ™Yes” to restart now or No ™ if you plan to

manually restart later.

20. Connect the USB Security Key to the USB port of your computer. The
Windows Hardware Manager should detect the USB device as Safenet USB
SuperPro/UltraPro and should automatically install the driver for the device.

Note: It is recommended the security plug be connected directly to the
computer instead of through a USB hub or keyboard port if possible.
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Metrics Codewords

Metrics Technology software products use a combination of a hardware Security
Key and Codeword. The unique combination of a Codeword and Security Key
allows the software product to be run on a any workstation PC.

Software Codeword Information

There will be a codeword for each software component ordered. This information
is made up of two (2) parts, the Registration Information and Codeword
Information. We encourage all customers to register their software with Metrics
Technology. Only registered users will receive technical support for their products.

Customer ID

The Customer ID is a number that has the form IAXXXXXA. Where the X
is a number. Variations include [HXXXXA, MHXXXXXA, and
MKXXXXXA. This number must match the number on the Security Key.

Product Desc

This is the Product Description. This will be the name of the product, such as
Metrics Win4156 or Metrics Win4156.

Product ID

The The product ID is MTW4145 should be entered in the ID field

Version

This is the version of the software i.e. 4.1.0

Note: The version number and the codeword are matched. Thus, customers
who have not purchased an upgrade will not be able to run it without
purchasing the correct codeword.

Codeword Serial

Example Codeword

AWRZI-XXC6Z-HK3EM-1RHUO0-GUJ8A-UPXOR
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Note: It is recommended that you cut and paste the codeword from the
registration e-mail sent from Metrics Technology Customer Service. If
typing the codeword from the keyboard be careful not to transpose letters or
numbers. The letter | can be confused for the number 1 and the letter O can
be mistaken for the number 0.

Entry of the Codeword Serial Number

The software Codeword Serial number can be manually entered in Win4156.

To Enter the Win4156 Codeword Serial number:

2. Open the Win4156 program. In Win4156 select the menu item Help »
Codeword to open the Software License Codeword window.

Software License Codeword &3

Please enter the Software License Codeword for the
ICS Product.

AWRZ-KXCEZ-HKIEM-1RHUD-GUJBA-UPXIR

| Ok | |Cance||

3. Enter the Win4156 Codeword Serial number supplied on the product
registration certificate.

4. Click the OK button.
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METRILCS

ICS Interactive Characterization Software

Win4156 Installation & Getting Started Guide

Metrics Win4156
Version 4.1.0

© Copyright 1999-2012, Metrics Technology, Inc.

All rights reserved.
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Introductory Information

Goal of This Manual

The goal of this manual is provide a process for the user to be able to create a test
and analyze the data with Metrics Win4156. A test setup will be created that
measures the Threshold Voltage of a MOSFET device. The measured data will then
be plotted and the Vth value will be extracted.
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Chapter 1- Win4156 Getting Started
Guide

Introduction

The first Chapter of the Self-Paced Guide introduces the Metrics Win4156 software.
This Chapter also provides important information on software versions and support.

Please note that each Chapter builds upon the information presented in the previous
Chapters. It is recommended that the Guide is followed in the order presented.

Topics Covered

What is Metrics Win4156 Software?
Overview of Metrics Win4156 Software
Updating Versions

Support
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What is Metrics Win4156 Software?

The Metrics Win4156 Software is an application designed for semiconductor
characterization applications. Measurements for different technologies can be created
in a matter of minutes without programming. It is based on the industry standard
Metrics Win4156 software and provides driver for the HP4156A/B.

Metrics Win4156 Controls:

e Semiconductor Parameter Analyzers
o HP 4156A
o HP4156B

Overview of Metrics Win4156 Software

Metrics Win4156 Software allows provides an environment for the collection of
data in three steps: Setup, Execute, and Analyze. The Setup of a Measurement
typically takes no more than 1-2 minutes.

Win4156 supports several measurement modes to accommodate most testing
methods.

The Analysis tools in Win4156 include plotting and data extraction. Once the
functions are created, they can be saved with the data.

The advantage of Win4156 is that once a test is created and saved it can be re-
opened and used again, including the analysis.
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Determining Software Version

The software version and build date are very important when requesting support.
Without this information it is impossible to provide efficient service. Please be
prepared to provide this information when seeking support.

To determine the software version:

1. Open the Metrics Win4156 Software.
2. Click the Help menu item.

3. Click the About item.

About ICS &3

METRILS

ICS Interactive Characterization Software

Wersion 4.0.0 - HFOO

Copyright 1992-2012, Metrics Technology, Inc.

License # ML20000M
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Updating the Metrics Win4156 Software

Please keep your software up to date by downloading and installing the Metrics
Technology Hot Fixes. Your software will remind you monthly with a simple
reminder message to check for updated Hot Fixes. Often the issues addressed in the
updates are ones that you may just now be encountering.

Metrics Technology provides Service Patches to registered customers. Once a patch
has been created and verified by Metrics Technology, it is placed on our web site
(www.metricstech.com).

The patch can be downloaded from the web site. Please note the patches are very
large and will take time to download depending upon your connection speed. If you
have not registered your software, please do so now to become eligible for software
updates and support.

Support

Metrics Technology provides technical support to customers for one year after the
purchase of the Metrics Win4156 software. This support period includes a ninety
day period when telephone support is available. The remainder of the year’s support
is provided by email. Please refer to the Metrics Technology website
www.metricstech.com for options available to extend the support period.

All customers who request support must have registered their copy of Win4156 with
Metrics Technology. The form is provided as part of the software package or you can
visit the Metrics Technology web site and select the support link to access the
registration forms.

Support is available from Metrics Technology

Contact Metrics Technology by:
e Reviewing our web site.
e Logging in to your account at the Metrics Technology website and
submitting a support request.
To receive Technical Support services you will need:
e Registration Number (Customer ID)

e Version and Hot Fix Number
e Complete description of issue, including any error messages
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Chapter 2- Selecting Instruments

Introduction

The Module introduces the Metrics Win4156 (Control Software for HP4156A/B/C)
measurement engine and demonstrates how to create measurements with it.

Topics Covered:

e Selecting an Instrument
e Configuring the Instrument
e Polling an Instrument
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Selecting an Instrument Driver

Before creating a measurement, Win4156 must know what instrument is being used.
This is accomplished by configuring Win4156. Once an instrument has been
configured, Win4156 will remember this configuration. The only time Win4156
must be reconfigured is when the instrument is changed or the ICS40.INI file is
erased.

-~
.L_ia

1. Click the Select Instrument button.
2. Highlight the instrument to be added and click the Connect button.

Available Selected

demaoiv | Connect -= |
hpd155-6
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Configuring the Instrument

After the Instrument driver is selected, it must be configured.

1. Highlight the instrument to be configured and click the Config button.
2. Enter the GPIB address.

Available Selected

I—Im I—I

Config...

Polling an Instrument

To confirm that the instrument and Win4156 are communicating properly, poll the
instrument.
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HP-IE Address: 17 Instrument: HP 41564

ROM Versions:
Host: | 0106  smu:| 0108  ap:| 0100

HP4150 14 Configuration
Mame Type Description

SMUS  ABSENT Mot Present
SMUS  ABSENT Mot Present
PGU1  ABSENT Mot Present
PGUZ  ABSENT Mot Present
GMDU  ABSENT Mot Present

[ oK. ][Search][ Poll ]

1. Click the Poll button.
2. Click the OK button to close the Configuration window.
3. Click the OK button to close the Instruments window.
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Chapter 3- Creating Measurements

Introduction

The Module introduces the Metrics Win4156 (Interactive Characterization Software)
measurement engine and demonstrates how to create measurements with it. Special
demonstration drivers have been created to allow the development to be independent
of the instrument. For details about the instrument drivers provided with Metrics
Win4156, please refer to the Metrics Win4156 documentation. The steps to creating
a test method will be covered.

Topics Covered

e Creating a Sweep Measurement
e Creating a Spot Measurement
e Creating a Time-Based Measurement
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Create a Sweep Measurement

The following example demonstrates how to create a sweep measurement using
Win4156. This example uses the demonstration driver within Win4156.

To Create a Sweep:

1. Open the setup editor.

The Setup Editor is the place in Win4156 where the measurement is
configured. It can be opened by clicking the Setup Editor button.

Setup Editor
Mew Devices Sources Options
Copy Rename Delete Time

2. Click New to create a new setup
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3. Name the Measurement Setup

Each measurement must have a unique name. Before the measurement can
be created, it must be given a name. To name the measurement:

Mew Setup [ == |

Mame: SWEEP

| Ok || Cancel|

a. Entering a name then click the OK button.

4. Select Source Units

The source units correspond to the outputs of the instrument you are using.
Metrics Win4156 provides a graphical way to document the connections for

later reference. To add a source unit:

* ten | Dovee |[ Soumes | Opios |
(_copy || Rename || Dete | Time.. |

|_
C BN -4 B b

==

| SWEEP

7]

-

DEMON _SMU2
DEMON.SMU3
DEMOINV.SMU4
DEMONV VS
DEMON V52
DEMOINV VI

m

4

Source Units (2=

DEMON.SMUA *

[ Instruments ]

[ Source Units ]

T

a. Click on the Sources button to open the Source Units window.

b. Highlight the specific unit.

c. Click the blue box beside the device lead in the Setup Editor.
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To remove a source unit:

a. Highlight the attached unit.
b. Click the blue box beside the device lead in the Setup Editor.

c. Click the Yes button when asked if "Do you really want to remove the

source".
Setup Editor =2 ]
I Mew " Devices “ Sources " Options l
I Copy " Rename “ Delete H Time__. l ’SWEEF' -
|_
SMu2 [ | d -4 H B
=

Note: The graphic is merely a representation of the device. The software
does not expect behaviors from the data. Thus, the pin-out does not have to

exactly match, rather it is only for reference.

Installation and Getting Started 37



5. Configure Source Units.

In this example we are creating a sweep source, so we must configure the
source unit properly. To setup a sweep source:

SMU

SMU Setup 3
Source: | sMUA
Stimulus Measure Sweep Time
@ Voltage | Voltage VD Hold 0.0000
Current | Current  ID Delay 0.0000

Force Conditions

Mode | SWEEP - Start  0.0000 Volts
Type |LIM - Stop  5.0000  Volts

Ma. Points 51

Compl 0.1000 Step Size  0.1000  Volts
Time Stim Time Measurement Bias
@) Voltage Time Bias ~ 0.0000  Volts
Current Compliance 0, 1000
| Ok | | Cancel |

Select the stimulus type.

Select the values to be measured (see note below).

Click the blue box beside the device lead in the Setup Editor.
Select the sweep timing (see note below).

Select the Source Mode. In this case we want it to be Sweep.
Setup the sweep parameters.

ocoarwnE

Note: Most SMU's can only measure the signal that is not being sourced.
Therefore in this case we have selected the Stimulus to be Voltage resulting
in the Current being measured. The values returned for Voltage in this case
would be the calculated voltage steps. The opposite is true when the
Stimulus mode is set to Current. The Sweep Time parameters are to control
the rate of the sweep. Please note that these inputs vary for different
instruments.
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Create a Spot Measurement

In this example we will create a spot (or single point) measurement. Most of the
steps are the same or similar to creating a sweep measurement. The first step is to
open the setup editor. The setup editor can be opened by clicking the Setup Editor

button.

To Create a Spot Measurement:

1. Open the setup editor.

The Setup Editor is the place in Win4156 where the measurement is

configured. It can be opened by clicking the Setup Editor button.

Setup Editor

Mew Devices

Time

Options

2

Done
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2. Name the Measurement Setup.

Each measurement must have a unique name. Before the measurement can
be created, it must be given a name. To name the measurement:

o)

Mew Setup =

Mame: SPOT

| Ok || Cancel|

a. Click the New button and type in a name.
b. Click the OK button after entering the name.
c. Select Source Units.

The source units correspond to the outputs of the instrument you are using.
Metrics Win4156 provides a graphical way to document the connections for
later reference. To add a source unit:

'SetupEdi'tor @“
[ Mew " Devices " Sources " Options ]
[ Copy " Rename " Delete " Time.__. ] lSF'OT vl
rSDurceUnits IEd
DEMOIV.SMU2 -
D DEMOIV.SMU3
B DEMOIV SMU4
DEMOIV. VST £
DEMOIV V52
DEMOIV. V1
|_ DEMOINV VM2 &
G B 14 I
= [ Instruments ]
[ Source Units ]
B [ Done ]
S

a. Click on the Source Units button to open the Source Units window.
b. Highlight the specific unit.
c. Click the blue box beside the device lead in the Setup Editor.
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Setup Editor
| Mew H Devices ‘| Sources " Options ‘
| Copy |‘ Rename ‘| Delete " Time... ‘

SMU

SMU2

|sPOT

Done

To remove a source unit:

a. Highlight the specific unit.

b. Click the blue box beside the device lead in the Setup Editor.

c. Click the Yes button.

Note: The graphic is merely a representation of the device. The software
does not expect behaviors from the data. Thus, the pin-out does not have to

exactly match, rather it is only for reference.
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3. Configure Source Units.

In this example we are creating a spot source, so we must configure the
source unit properly. To setup a spot source:

SMU

SMU Setup =
Source: | sMU1
Stimulus Measure Sweep Time
o "."l:lltElgE ] ll."l:lltﬂgE VD Haold | 0.0000
Current o|Current 1D Delay | 0.0000

Force Conditions

Mode |CONST Value  P.0o00 | Volts

Compl  0.1000

Time Stim Time Measurement Bias
@ Yoltage Time Bias  0.0000  Waolts
Current Compliance  0,1000
| oK | | Cancel |

Select the stimulus type.

Select the values to be measured (see note below).

Select the Source Mode. In this case we want it to be Const.
Setup the source bias.

el A

Note: Most SMU's can only measure the signal that is not being sourced.
Therefore in this case we have selected the Stimulus to be Voltage resulting
in the Current being measured. The values returned for Voltage in this case
would be the calculated voltage steps. The opposite is true when the
Stimulus mode is set to Current. Please note that these inputs vary for
different instruments.
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Creating a Time-Based Measurement

In this example we will create a time-based measurement. Most of the steps are the
same or similar to creating a spot measurement. The first step is to open the setup

editor.

To Create a Time-Based Measurement:

1. Open the setup editor.

The Setup Editor is the place in Win4156 where the measurement is
configured. It can be opened by clicking the Setup Editor button.

Setup Editor [2= |
Mew Devices Sources Options
Copy Rename Delete Time

Done
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2. Name the Measurement Setup.

Each measurement must have a unique name. Before the measurement can
be created, it must be given a name. To name the measurement:

’Newﬁetup @

Name: TIME|

[ Ok ” Cancel|

a. Click the New button and type in a name.
b. Click the OK button after entering the name.
c. Select Source Units.

Setup Editor @

[ New || Devess || Souces | oOpions |

l Copy " Rename " Delete " Time... ] E - |

Source Units (2|

DEMOINV_SMUA -
DEMOINV.SMU2

DEMOINV.SMU3
DEMON_SMU4
DEMOIV. VST
DEMOIV V52
DEMOIV. VM

| =

m

1

G B ]

g b

TLT

[ Instruments ]

[ Source Units ]

Done ]

The source units correspond to the outputs of the instrument you are using.

Metrics Win4156 provides a graphical way to document the connects for
later reference. To add a source unit:

v [l
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Setup Editor

I New “ Devices “ Sources " Options |
I Copy “ Rename “ Delete " Time... I | TIME

SMUA
B

=
G N -4 B B [Bi|swu4
=

Done

a. Click on the Source Units button to open the Source Units window.

b. Highlight the specific unit.

c. Click the blue box beside the device lead in the Setup Editor.

To remove a source unit:

a. Highlight the specific unit.

b. Click the blue box beside the device lead in the Setup Editor.

c. Click the Yes button.

Note: The graphic is merely a representation of the device. The software
does not expect behaviors from the data. Thus, the pinout does not have to

exactly match, rather it is only for reference.
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3. Configure Source Units.

In this example we are creating a time stimulus source, so we must configure
the source unit properly. To setup a time stimulus source:

SMU1

SMU Setup ==
Source: | sMUA
Stimulus Measure Sweep Time
o "."l:lltﬂgE v "."l:lltﬂgE in] Haold | 0.0000
Current | Current  ID Delay | 0.0000

Force Conditions

Mode | CONST - Value 0.0000 Vaolts

Compl 0.1000

Time Stim Time Measurement Bias
@ Voltage Time Bias | 4.0000  Volts
Current Compliance 10,1000
| Ok | | Cancel |

a. Select the stimulus type.
b. Select the values to be measured (see note below).
c. Select the Time Bias and Compliance.

Note: Most SMU's can only measure the signal that is not being sourced.
Therefore in this case we have selected the Stimulus to be Voltage resulting
in the Current being measured. The values returned for Voltage in this case
would be the calculated voltage steps. The opposite is true when the
Stimulus mode is set to Current. Please note that these inputs vary for
different instruments.
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4. Set Time Parameters.

We must specify the time interval that the measurements will be made. To
setup the time parameters:

Time._. |

Setup Editor @“
l Mew “ Devices “ Sources " Options ‘ Time Parameters
l Copy “ Rename “ Delete " Time. .. l \TIME - Units
@ Sec
SMU1 > Min
O Hrs
D I
Type [LIN -
|
Wait 00000
I_ Start  0.0000
G N -4 Stop 10.0000
I- Points 11
Step 1.0000
|
5 [T Comply to Stop

Dane Done

SMU3

Select the Time Units.
Select the sampling type.
Enter the Wait time.

Enter the Start, Stop, and Step values. Select the Comply to
Stop, option if desired.

o0 o
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5. Set Measurement Mode.

We must specify the measurement mode as Time Meas. To setup the
measurement mode:

N/

Measure
TIME -
P | Single
G2 | Repeat
b M| Append
| History
S | Auto
4
TIME MEAS ~ ~|
l ustw | | 2D
STBY ZERD
TFF CANEL
B | Stop

a. Select the Setup.
b. Select the TIME MEAS mode.
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Chapter 4- Executing Measurements

Introduction

This Module details the execution of the measurement using Win4156.

Note: When creating new tests it is necessary that the data be measured before the
analysis is created.

Topics Covered

e Measurement Remote Control
e The Date Window
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Measurement Remote Control

Metrics Win4156 contains a tool named the Measurement Remote Control. This

control is activated by clicking the Measure button on the Win4156 toolbar.

@

This toolbar contains buttons to begin the measurement as well as menus to select

the measurement and mode.

Note: The remote control window can be moved anywhere on the desktop.

-

Measure

Single

4
G2 | Repeat

M | Append
__| History
S | Auto

The Measurement Remote Control has four sections.
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Section 1: Measurement Menu

This pull-down menu allows the selection of a specific test to be executed.

Section 2: Execute Buttons

This section contains the buttons that will start the measurement. Several
modes of measurement are available and the buttons correspond to the
selected mode.

Section 3: Measurement Mode Menu

This pull-down menu allows the selection of the measurement mode. Most
measurements are made in standard mode, however Win4156 does support
several specialized measurement modes which require this to be modified.

Section 4: Stop Button

This button allows the user to stop the measurement.
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The Data Window

When a new setup is created the spreadsheet is automatically created when a test
setup is created. It will begin as a minimized window in the lower left corner of the
Win4156 window. To view the data simply double-click the window that has the
same name as the test setup.

VTH

(=& 5=

[;

Clear H Max H Min ][ Direct ]

080712012 1

ID [viE [T + [GM + [GMMAX + |TFIT + -

1 007500 0.0000 15972 05307  20.0000 -0.5888m
2| 016800 0.1000 18787 0.5519m
3| 04507 0.2000 5.9548p 0.5151m
4]  1.3550p 0.3000 0.0152n -0.4782m
5|  4.2856p 0.4000 0.0642n 0.4414m
6| 001420 0.5000 0.2216n -0.4045m
7| 004860 0.6000 0.7988n -0.3676m
8| 01740 0.7000 3.0511n -0.3308m
9] 065880 0.2000 0.0117u -0.293%m

10|  25201n 0.5000 0.0458u -0.2570m

1] 9.8193n 1.0000 0.1850u

17 MGk 1 i M7 GG

4] |

0. 2202m
N9 f
3

The Data window automatically returns the measured data and displays it. When
parameters are extracted the values are also displayed.

Note: Win4156 has a feature named "Enable DataView". To enable or disable this
feature select Workspace from the Options menu.

Workspace @
Default Plot Colors
Curve: Axis:
Mumbers: Labels:
Title: Window:
Cursors: Active Cursor:
Options:
Font [Arial v] |¥] Show Messages
Export Delimeter [ Eng Notation
Sigrificant Digits Enable Data View
[¥] Autoscale
Default Device [#] Update During
Sync dataview
[ ok || pefaults || Fiie Mgr Setup... |
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Edit the DataView

él.zm N
EESE)
[ Define Data View |
Setup Mame: "u’TH v]
Data Orientation:

@ Column Vectors
["| Append data only to

Row Vectors View Vectors.
Data Vectors: View Vectors:
EREE - | [ pgas | [Coit: D
D —— [Col 2: VG
VG Insert -= Col 3: VT
=M 2 ——  |[Col 4: GM
G A —— 1 |Col & GMMAX
TFIT Remove | oo TAIT
VT N
TIVME i Remaove All

This feature allows the user to select that only data vectors that are chosen be
displayed. It also allows the reordering of the data vectors as they appear in the data
window. The default behavior is for the DataView to be disabled which displays all
vectors for a chosen setup.
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Sync the DataView with Microsoft Excel

This feature allows the user to automatically synchronize all DataViews with a
Microsoft Excel workbook. The default behavior is for the DataView to be disabled
which displays all vectors for each setup in separate tabs of the workbook.

Note: Win4156 has a feature named "Enable DataView". To enable or disable this
feature select Workspace from the Options menu.

Note: Win4156 has a feature named "Sync dataview". To enable or disable this
feature select Workspace from the Options menu.

rWorkspace @

Default Plot Colors

Curve: m Axis: Gray—v
Mumbers: I,,n,lh.te—v Labels: LtGray—v

Title: Wh,te—v Window: |3|a.;k—v

Cursors: '|.|'|.|'h|te—v Active Cursor: m
Options:
Font |Aria| vl | Show Messages
Export Delimeter | TAB ~ | [¥|Eng Notation
Sigrificant Digits Enable Data View

V| Autoscale
DefaultDevice  |MOSFET  w| []Update During

Sync dataview  |ms Excel -

| ok || Defaults || File Mor setup... |

UL

While the "Sync DataView" is selected all data will be automatically synced to the
Excel spreadsheet. You can create user defined macros to perform further analysis
to create custom reports and save out to the file system in .XLS format.

Notice that not only the measured data vectors are synced but also any transforms
that have been setup for the raw data.
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L VTH E=E(E=E
| Clear | [ Max ] [ Min ] [ Direct ] 08{07/2012 1¢
ID [VE |GM = [GMMAX + [TFAIT+  [VTH+ | «
1 0.1087p 0.0000 1.3488p 200000, -0.2533m 1.5972 ]
2 0.2435p 0.1000 272527 -0.7955m
3 0.6532p 0.2000 3.6301p -0.7465m
4 1.9656p 0.3000 0.0278n 0.6931m
b 62109 0.4000 0.0930n -0.63%6m
] 0.0206n 0.5000 0.3212n -0.5862m
7 0.0704n 0.6000 1.1577n 0.5328m
] 0.2521n 0.7000 4. 418n 0.4754m
9 0.9548n 0.2000 0.0170u -0.4255m
10 3.6524n 0.5000 0.0664u 0.3725m
11 0.0142u 1.0000 0.2680u 0.31%1m
12 0.0573u 1.1000 1.0578u 0.2657m -
<] | W
|rc!5'l . (= pi S Bookl - Microsoft Excel - = x
- Home ||Ir|sert|| Page Laycuul Formulas | Data | Review |‘u"iew |Team |@ - 3 X
ﬁ? 22 S | &l i Q; Text Box =%
_ - : (- : 2] Header & Footer kgg
Pwo?’able Table Picture Chfrts Hyperlink ﬂWnrdAr‘c' Q
Tables Mustrations Links Text
| Al - fe | ID ¥
A 2] C D E F G L
1 (ID Wia GM + GMMAX + TFIT + WTH+
2 | 1.09E-13 0 1.35E-12 20 -0.00085 1.597227
3 | 2.44E-13 0.1 2.72E-12 -0.0008 3
4 | B8.53E-13 0.2 B8.03E-12 -0.00075
5 | 1.97E-12 0.3 2.78E-11 -0.000a69
6 | 6.21E-12 0.4  9.3E-11 -0.00064
7 | 2.06E-11 0.5 3.21E-10 -0.00059
8 | 7.04E-11 0.6 1.16E-09 -0.00053
9 | 2.52E-10 0.7 4.42E-09 -0.00048
10| 9.55E-10 0.8 1.7E-08 -0.00043
11 3.65E-09 0.9 6.64E-08 -0.00037
12 | 1.42E-08 1 2.68E-07 -0.00032
13 | 5.73E-08 1.1 1.06E-06 -0.00027

2.26E-07

4.01E-06

-0.00021

Ready |

[

1.2
u 4 ¥ M| VTH -~ Sheetl - Sheet2 /sheeta dI-, m
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Chapter 5- Plotting Data

Introduction

This Module introduces the plotting tool of the Win4156 software. The plotting tool
allows for the graphical analysis of data measured with Win4156.

Topics Covered

e Creating a Plot
e Editing a Plot
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Creating a Plot

The Metrics Win4156 software uses a custom plot tool to display plots and provide
analysis features like read-out cursors and line fits.

To create a new plot:

1Y

Setup Plot View ==

Plot Definition:

Axis Options: | X-xis... | | |Y1-auis...| [ |v2-Axis...|

Data Group: IUG vl ’|[} vl ’GM vl

ScaleType: [UN  ~||[un  ~|[[un  +|

Min Value: 0 -0.0002 -0.0001
Max Value: 4 0.0006 0.0004
| Done | | Cancel | | Apply | | Build Group

1. Click the Plot button on the toolbar.
2. Configure the plot.
3. Click the Done button and the plot will be created.
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L7 VTHL =N EsR=
Title
g 0.8000m 0.4000m Conditions:
= - Con: SMUT
| 0.5000m | ] Val: 0.0500 V
C 0.2000m
0.4000m Swp: SMUZ
= Start: 0.0000
i 0.2000m £ Jo.z000m Stop: 4.0000 V
2 ] 1 =
o = Step: 0.1000 V|
0.2000m
é Q o2 = ‘ O |t a1
2.1000m E. 0.1000m
o Con: SMU3
0.0109n Fasecvecocosas . Val: 0.0000 V
L | NN Jo.oooo
0.1000m :_ Con: SMU4
2 E Val: 0.0000 V
= C
ozoo0mbe o o by o by, -0.1000m
L 0.000 1.000 2,000 2,000 4.000
o
= VG
IC3 13:50:53
08/07/2012

Note: The plot is made from whatever data window is currently active. The
name of the plot in the Window title is the setup name followed by a dash
and a number. Multiple plots can be created from the same data set, the

number will just increase.
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Editing a Plot

1 viha =)

Autozcals Title

HIHE

x| Y.
T fod
5 [
© [od
% [od
[ [od

LIS

CUTS0Ts

O e | =2 P I :
" Fit &1 : 1.000 2.000 2.000 4.000
& Fit #2. VG
E foomIn || Zoom Out ]| Owerlay | Memory
& o | o | e

The plot window contains the editing tools for the plot.

1. The Axis button reveals the tools to change the axis from linear to
logarithmic and to auto scale the plot.

2. The Cursors button allows the addition and control of cursors on the plot.

3. The Fits button allows the application of curve fits related to the cursors.

4. The Opts button presents several options for adding notes to the plot,
overlaying plots, zooming features, and setup changes.

These functions are discussed in great detail within the Win4156 Reference Manual.
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Chapter 6- Extracting Data

Introduction

After executing a measurement, Win4156 can extract parameters. Once the
procedures are defined, each time the measurement is run the calculations are
performed automatically.

This Module demonstrates how to extract parameters from the raw data using the
Transform Editor within Win4156.

Topics Covered

e The Transform Editor
e Defining a Transform
e Sharing Data Between Transforms
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The Transform Editor

Calculations are created within the Transform Editor. To open the editor, click the
"Transform Editor" button on the Win4156 toolbar.

f(x)

'

Transform Editor

Setup Mame: ’UTH

Transfarm:

=

Edit Constants_..

GM=DELTA(IDVDELTAVG)
GMMAX=MAXPOS(GM)
THT=TANFIT(VG.ID, GMMAX)
WT=XINT(TFIT)

A0 [emmeme] (][]0
Functions: Vectors: Constants:
ABS -~ | |ID = | |PI [rad] -
ARCCOS [ VG K [JK] [
ARCSIN GM(+) = |Q [C] 3
ARCTAN GMMAX[+) MO [kq]
AT TFIT(+) EV [J]
AVG - | |VT(+) = | [UD [Him] -
| Done | | Save | | Clear | | Delete |De|ete All | | Insert |

The Transform Editor contains several areas:

1. Transform Entry Box

The location to enter the transform.

2. Defined Transform List

A list of all transforms defined for this setup.
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3. Function List

A predefined functions available for the calculation of parameters.

4. Vector List

A list of the measured and calculated data vectors.

5. Constant List

A list of constants that can be used in calculations.

6. Edit Constant Button

Allows constants to be defined and edited.

7. Action Buttons

Controls for the saving of transforms, deleting of transforms, and exiting the

Transform Editor.
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Defining a Transform

Calculations are created within the Transform Editor. To open the editor click the
"Transform Editor" button on the Win4156 toolbar.

=

Transform Editor @

Setup Mame: [‘l.ﬂH v]

|Edit Constants. .. |

Transform:
GMMAX=MAXPOS(GM)|

GM=DELTA(ID)/DELTA(VG
TFIT=TANFIT(VG.ID,GMMAX)
VT=XINT(TFIT)

L] <Backspace] [+ [ - J[+ ][/

Functions: Vectors: Constants:

ABS -~ | |ID = [ [Pl [rad] -
ARCCOS |:| VG K K] r
ARCSIM GM{+) ‘E‘ Q [C] ‘i‘
ARCTAN GMMAK(+) MO [ka]

AT TEIT{+) EV [J]

ANG - | |VT{+) = | [UD [Him] 57
| Done | | Save | | Clear | | Delete | Delete All | | Insert |

To create a calculation:

1. Enter the calculation in the "Transform" box. The calculation must be
in the form result=function(vector)

Click the Save button to save the new calculation.

3. Once all calculations have been saved, click the Done button.

N
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Sharing Data Between Transforms

Data vectors from one setup can be shared with another setup in the same project
file. For instance, if one setup (TEST2) measures the resistance from 0-1 Volts and
the second (TEST1) from 1.1-2 Volts the data can be merged to form a full sweep

from 0-2 Volts.

To Share Data:

We must first create two different setups with TEST2 being the sweep from
0-1 Volts and TEST1 being the sweep from 1.1 to 2 Volts.

[ Transform Editor @ﬁ
Setup Name: |TEST2 s Edit Cunstants.._|
Transform:

VAHI=TEST|WVA
[AHI=TEST|IA

( JL. Jlo ) |sBackspace| [+ || - J[ = ]| ¢
Functions: Vectors: Constants:
ABS - VA Pl [rad] -
ARCCOS 14 K[K] I
ARCSIM VAHI+) Q [C] 3
ARCTAN LAHI+) MO [ka]
AT TIME BV [J]
AVG - | |[ACCSTRESS UO [Him] *
| Daone || Save || Clear || Delete |De|etehl||| Insert |

1. Open the Transform Editor and make sure the setup name is TEST2.
2. Create a new Transform as shown above.
3. Click the Save button.
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The use of the transform result=setup name|vector name allows the data to

be moved from one setup to another.

o

B TEsT (= |[= ] =
Clear ] [ Max ] [ Min ] [ Direct l 08Jjo7 20
VA 14 | | -
1 0.0000 0.104%
2 0.1000 4 4441p
3 0.2000 0.4726n
4 0.3000 0.0778u
h 0.4000 2.8933u
6 0.5000 0.1426m
7 0.6000 0.3110m
8 0.7000 0.4251m
9 0.3000 0.5255m
10 0.5000 0.6055m
11 1.0000 0.686Tm
12
13 .
14
4] | f

After applying the transform result=setup name|vector name the data to be
from TESTL1 is displayed in the data window for TEST2.

-

& TEST2 (o= =
[ Clear H Max H Min H Direct l 0807201
VA [1A [vaHI +  [1AHI+ | | -

1 11000, 0.1051p 0.0000  0.104%

2 11900 44496 01000  4.4441p

3 12800 0473 02000,  0.4726n

4 13700, 0.077% 03000, 00778

5 14600  8.9044u 0.4000  88%3%

6 15500  0.1428m 0.5000  0.1426m

7 16400  0.3114m 06000  0.3110m

[ 17300, 0.4297m 07000, 0.42%1m

9 1.8200  05261m 0.8000  0.5255m

10 19100  06103m 0.3000  0.6095m

11 20000  0.686%9m 1.0000  0681m

12

13 .
4] | f
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Chapter 7- Saving Data

Introduction

Metrics Win4156 version 4.1.0 saves the data within the standard Windows File
System. This Module covers the data. Where it is stored, how it is stored, and how to
retrieve it are covered.

Topics Covered

e Where is the Data?
e Saving a Project
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Where is the Data?

Metrics Win4156 version 4.1.0 allows the data to be stored anywhere within the
windows file system.

Note: If you want the Win4156 Backup utility to save the data, make sure it is saved
within the Metrics\ics\projects directory.

Saving a Project

The project is a collection of the test method(s) and the data. To save the data
simply select File >> Save As and select the directory and filename or to save the
currently open project simply select the Save toolbar icon.

o U
|
File Save As ==
QQ | . v Computer » BOOTCAMP (Z:) » dev » metrics » bin » ics » projects = | LS | | Search projects o |
Organize * New folder =~ M @
& Favorites i Mame : Date modified Type Size
Bl Desktop i b1505-diode 9/29/2011 7:29 PM  iCalendar File 13KE
4. Downloads :ﬁ B2900test 7/27/201210:31 AM  iCalendar File 15KB
| Recent Places :ﬁ B2900test2 7/28/201211:15 AM  iCalendar File 10KB
i ics2600-mos 7/11/201210:31 AM  iCalendar File 26 KB
- Libraries = ] ics4145-mos 8/6/201212:59 PM  iCalendar File 18 KB
3 Documents i ics4156-dinde 6/27/2012 4:45 PM  iCalendar File 12KE
rJ'- Music EH icsS270t 11/21/2011 8:43 AM  iCalendar File 9 KB
k=| Pictures ] ics5270vt2 11/21/2011 1:28 PM  iCzlendar File 18 KB E
[=7 Subwversion :ﬁ icsatdld5 8/6/2012 2:23 PM iCalendar File 11 KB
B8 videos i icsb2900-mos 7/24/2012 216 PM  iCalendar File 9KB
[ :@ icsb2912-mos 7/25/2012 9:56 AM iCalendar File 16 KB
1% Computer :ﬁ 1csKI2600-fast 7/24/2012 1:34 PM iCalendar File 17 KB
5 escher (\\terastni :ﬁ icvd142 3/5/200912:24 PM iCalendar File 58 KB
‘T_"-'. BOOTCAMP (C:) i icv14s 3/5/200912:24 PM  iCalendar File 56 KB
= Macintosh HD (E :ﬁ icvd156 3/5/2009 12:24 PM iCalendar File 42 KB
a GMax (F) i icva284 3/5/200912:24 PM  iCalendar File 20KB
5 dev.Advancedins i icvka2 3/5/200912:24 PM  iCalendar File 31KB
¥ prod.mages (\\.C ] icvkao 3/5/200912:24 PM  iCalendar File T2KB
S i emnn I/EFINANA IS ORA i alanadar Cila 10 ve
File name: | - [ICS Project (*.ics) Vl
[ Open |v] [ Cancel ]

Installation and Getting Started 67




